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Before using your machine for the first time, 
it is important to read the whole of this 
installation and maintenance manual.

All necessary operations and interventions 
on this machine must be performed by a 
qualified technician.

Our technical support service will be 
pleased  to provide any additional 
information you may require.

The various interventions described in  
this manual are accompanied by 
recommendations or symbols to alert the 
user to potential risks of accidents. It is vital 
that you understand and take notice of the 
various warning symbols used.

This AVR can be incorporated in a 
CE‑marked machine.

Warning symbol for an operation capable 
of damaging or destroying the machine 
or surrounding equipment. 

Warning symbol for general danger to 
personnel. 

Warning symbol for electrical danger to 
personnel. 

Note: LEROY-SOMER reserves the right  
to modify the characteristics of its products 
at any time in order to incorporate the  
latest technological developments. The 
information contained in this document may 
therefore be changed without notice.

WARNING

This manual concerns the alternator AVR which you have just purchased.

We wish to draw your attention to the contents of this maintenance manual. By following 
certain important points during installation, use and servicing of your alternator, you can 
look forward to many years of trouble-free operation.

SAFETY MEASURES
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All servicing or repair operations performed on the AVR should be undertaken by 
personnel trained in the commissioning, servicing and maintenance of electrical and 
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PRESENTATION1 - 

Operation1.1 - 

A schematic diagram of the D500 appears below.
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Terminals Signals Scheme
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Z2
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- PMG input
- SHUNT input
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Terminals Signal Scheme
F+
F-

Field excitation:
up to 10 A F+

F- Exciter
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• Power: It varies according to the type of 
field excitation (3 types).

- AREP: The AVR is powered by two auxiliary 
windings which are independent of the 
voltage sensing circuit.
The first winding has a voltage in proportion 
with that of the alternator and the second 
has a voltage in proportion with the stator 
current.

- PMG: A permanent magnet generator 
(PMG) added to the alternator supplies the 
AVR with voltage which is independent of 
the main alternator winding.

- SHUNT: The AVR is powered by the main 
winding (140 V – 50/60 Hz).

• Battery: This is used to supply the AVR 
with between 12 V and 30 V. It must always 
be present.

• Mains: This input is dedicated to the 
phase-to-phase mains voltage which will be 
taken as the reference when voltage 
matching is performed.

• Alternator voltage: This sends the 
alternator output voltage to the AVR in:
- three-phase (U, V, W)
- single-phase (V, W)

• Current transformer(s): This input 
measures the current supplied by the 
alternator. It must always be present when 
the alternator is running in parallel 
operation.

• The possible configurations are:
- 1 CT on phase U
- 3 CTs on phases U, V and W

• Temperature sensor(s): These are used 
to measure the alternator temperature and 
alert the user if there is a rise in temperature. 
This measurement can be taken either with 
1 PTC or 3 PT100s.

• Communication:
- USB port: This is used to connect the AVR 
to a computer and creates the link between 
the EasyReg software and the D500.

- CAN port: This is used to connect the AVR 
to a computer and creates the link between 
the EasyReg software and the D500.
The CAN link is only available in the  
CAN version identified by the letter C 
(eg: D510-C).

• I/O: This part is used to:
- Enter settings 
- Send information from the D500
- Receive information from the alternator

• LEDs: These light-emitting diodes inform 
the user whether the AVR is working correctly 
or not.



Installation and maintenance

D500
Automatic Voltage Regulators (AVRs)

8

4243 en - 2009.09 / aLEROY-SOMER

Characteristics1.2 - 
The different functions of the D500 are:
- Voltage regulation
- Regulation of the power factor (PF)
- Regulation of the reactive power
- Manual regulation (Iexc)

• Voltage regulation: The D500 regulates 
the alternator output voltage. Regulation is 
applied to the mean value or the true rms 
value (TRMS).

• Regulation of the power factor: The 
D500 regulates the power factor. This is  
the ratio between the active power  
(P = √3*U*I*cos φ) and the apparent power 
(S = √3*U*I). 

- Inductive cos φ [0; π/2] means that the 
current is lagging behind the voltage. The 
load is inductive (induction motor, 
transformer, etc).
- Capacitive cos φ [π/2; π] means that the 
current is leading the voltage. The load is 
capacitive (fluorescent lighting, etc). 

• Regulation of the reactive power:  
The D500 regulates the reactive power  
(Q = √3*U*I*sin φ) at a fixed value.

• Manual regulation: The D500 can regulate 
the voltage manually by altering the value of 
the excitation current.

These functions are selected when setting 
the AVR parameters.

Specifications1.3 - 
Characteristics1.3.1 - 

Name Minimum value Maximum value Adjustable
Battery power supply 11 V 30 V
Alternator frequency 10 Hz 100 Hz Yes

Mains frequency 5 Hz 100 Hz
Single-phase mains voltage 50 V 600 V

Mains voltage ratio 1 100 Yes
Excitation current 0 A 6 A

Max. excitation current 0 A 10 A
Single-phase alternator voltage 0 V 341 V
Three-phase alternator voltage 0 V 600 V

Alternator current input 1 A 5 A Yes
Alternator I u 0 A 5000 A
Alternator I v 0 A 5000 A
Alternator I w 0 A 5000 A
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Characteristics1.3.2 - 

Name Minimum value Maximum value Adjustable
LAM knee-point 37 Hz 100 Hz Yes

Adjustable LAM 70% of
Voltage reference

100% of
Voltage reference Yes

Variable U/F 1.0 3.0 Yes
Voltage reference setpoint 90 V 690 V Yes

Adjustment of external accuracy - 10%*  + 10%*  Yes*
Quadrature droop 0% + 10% Yes

Soft start acceleration 0.1 s 120 s Yes
Loading acceleration 0.1 s/10 Hz 30.0 s/10 Hz Yes

Voltage drop compensation 0% 10% Yes
Excitation current manual reference 0 A 10 A Yes

Rated cosine -0.6 (LEAD) +0.6 (LAG) Limited by settings
kVAR -100% +100% Limited by settings

Proportional action  0* 1500*  Yes*
Integral action  0* 200*  Yes*

Derivative action  0*  12000*  Yes*
* ± 30% in expert mode

Status and faults1.3.3 - 

Name Minimum value Maximum value Adjustable
Short-circuit delay 0.5 s 10 s

Short-circuit excitation 
current demand 0 A 10 A

Underexcitation delay 0.1 s 5.0 s
I EXC SHUT down 0 A 5 A
Overvoltage time 0 s 100 s

Overvoltage threshold 0% 120%
PT100 temperature 0°Celsius 250°Celsius

PT100 temperature threshold 50°C 200°C
PTC input 0% 100%
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human-machine Interface2 - 
The D500 human-machine interface 
consists of 3 elements:
- The USB link
- The I/O
- The LEDs

Communication2.1 - 
USB link
The EasyReg software and the D500 
communicate via a USB cable (Universal 
Serial Bus).

I/O2.2 - 
This part of the board allows the operator to 
use the inputs to make manual settings and 
the outputs to check certain data or to 
indicate whether certain AVR functions are 
working correctly or not. An external power 
supply (0 V – 10 V) is present which can 
supply an external component (bulb, alarm, 
etc).

The minimum input setting is 0% and the 
maximum is 100%.
External setting is either:
- from an external potentiometer
- 4 - 20 mA
- 0 - 10 V
- ± 10 V
Scaling:

(AVR part)yx Formula
	

x Formula y

4 – 20 mA A * x + B = y
A = 6250 and B = -25 0 – 100%

0 – 10 V A * x + B = y
A = 10 and B = 0 0 – 100%

-10 – 10V A * x + B = y
A = 5 and B = 50 0 – 100%

LEDs2.3 - 
The LEDs serve to inform the user whether 
the AVR is working correctly or not.

Name Colour Meaning

Power ON Green The board is supplied  
with power

↓ Hz Red Speed drop

↑ / ↓ Volt Red Problem of overvoltage or 
undervoltage

↑ / ↓ Exc. Red Problem of overexcitation 
or underexcitation

 Fault Red Problem on the exciter 
field diode bridge

Manu Yellow Manual mode enabled

PF/KVAR Yellow
Regulation of the power 
factor or reactive power 

enabled

U = U Yellow Alternator voltage =
Mains voltage

USB Blue AVR connected

USB port

I/O
LEDs

Connect to the PC

Connect to the D500
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Wiring scheme2.4 - 
AVR connections:

� Power:
- AREP: Yellow wire on X1 - red wire on Z1 - green wire on X2 - black wire on Z2
- PMG: X2, X1 and Z2
- SHUNT: X1 and X2
� Field excitation: The field winding + to the terminal F+

The field winding - to the terminal F-
� Battery: Ensure the polarity is correct when connecting
� Voltage sensing:

- Mains voltage: L1 and L2
- Alternator voltage: - single-phase: V and W

- three-phase: U, V and W
� Current transformer(s):

- Placing in parallel and measurement: CT on U
- Measurement: CTs on V and W
� Temperature sensor:

- PTC: see mounting above
- PT100: see mounting above
� USB port
� Digital I/O

1
2

3

4

5

6

7

8
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SETTING THE FUNCTION 3 - 
PARAMETERS

Help with explanation of the function.
The EasyReg software is used to:
- Set the AVR parameters.
- Configure the inputs and outputs.
- Display faults and parameter measure
ments. 
It is the interface between the user and the 
digital AVR.

Installation3.1 -  	
A CD-ROM is used to install the software on 
a PC. Subsequently, the link between the 
computer and the AVR will be via USB cable. 
The PC therefore needs to have a CD-ROM 
drive and a USB port.
1 - Installation procedure: insert the 
installation CD-ROM in the computer drive.

2 - The installation menu appears. Click on 
the "install" button and follow the 
instructions.
If the menu does not appear, go to My 
Computer and double-click on the CD-ROM 
drive.

Startup3.2 - 
Connect the AVR to the computer with a 
USB cable. Check that the blue "USB" LED 
is on. 
To start the software, go to "Start", 
"Programs" then "EasyReg". 

Appearance3.3 - 
The home page below appears:
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There are three options when using this software:
- New configuration
- Open a configuration from a file
- Open a configuration from the pre-programmed AVR

If the AVR is not connected or has never been configured, it is impossible to "Open from a 
D500".

Saving and loading the configuration3.3.1 - 
Save your configuration (for the 1st time):
- Go into the "File" menu and click "Save As"
- Choose where you wish to save to
- Name your saved configuration
- Click Save As 

Subsequently, to save the configuration, you just need to go into the "File" menu and click 
"Save".
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Send the configuration to the AVR:
- Check that the AVR is connected correctly 
(blue LED on) at the bottom left-hand side of 
the screen.
- Go into the "Edit" menu and click  
"PC −> D500".
Wait for loading to complete.

- Select the communication type: USB or 
Serial.
- Go to: • PC --> D500

• D500 --> PC
New configuration3.3.2 - 

There are two possible configuration levels: 
standard or expert.
By default, the software is in standard 
mode. 

Standard3.3.2.1 - 
The AVR is programmed step by step. 
Access to the "Regulation Mode" page is 
only possible if the "Alternator Configuration" 
page has been filled in. The program is 
transferred to the D500 via the "Edit" menu 
then "PC => D500" or by pressing F10 on 
the keypad.
This software must be used in the order 
indicated below:
1. Alternator configuration
2. Regulation mode:

- Voltage regulation
- Underspeed settings
- Other types of regulation (PF, reactive 
power, manual) depending on the user's 
selections.

3. Faults and digital outputs
4. Monitors

Alternator Configuration3.3.2.1.1 - 
Open "New configuration" from the menu bar, which takes you to the "Alternator Configuration" 
window. The parameters for this page are set in two parts: Alternator, Options.
The wiring scheme varies according to the characteristics specified by the user.
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• Alternator In the dropdown lists or boxes, select:

1. The type of alternator

2. The length

3. The type of field excitation

4. The frequency

5. The number of stator outputs

6. The stator connections

7. The voltage sensing (single or 

three-phase)

1

2

3
4
5
6

7

Note: The information relating to items 1, 2, 3 and 4 can be found on the nameplate.

Stator connections: Click on the question mark to get help on the stator connections.
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The electrical schematic below shows how the "wiring scheme" part changes according to the 
parameters selected.

• Options
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To obtain the following options, tick the 
boxes:

1. Temperature sensors, select either 
1 PTC or 3 PT100s.

2. Current transformers (CTs), select the 
number (1 or 3), the measurement (IN, IN/2 
or IN/4) and the ratio (). They are compulsory 
for parallel operation.

3. Alternator voltage transformer, enter 
the voltage values at the primary and at the 
secondary.

4. Bus voltage transformer, enter the 
voltage values at the primary and at the 
secondary.

1

2

3

4

The electrical schematic below shows how the "wiring scheme" part changes according to the 
parameters selected.

After entering the data in this page, go to the second page by clicking "Next". In some cases, you 
will need to adjust the workscreen in order to access the "Next" button.
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Regulation mode3.3.2.1.2 - 
After entering the "Alternator Configuration" part settings, fill in the "Regulation Mode" part. Click 
"Next".

4 types of regulation are offered:
- Voltage
- Power factor
- Reactive power
- Manual

Always start with voltage regulation.
Caution, regulation of the reactive power PF and the quadrature droop can only be 
enabled if there is a CT on phase U and it has been selected.
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A - Voltage regulation
This page consists of two parts:

A1 - Voltage Regulation

To confirm, click "Next".

A2 - Underspeed settings

Setting the parameters for this part starts with the "Voltage regulation" page and ends with the 
"Underspeed settings" page.
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A1 - Voltage regulation
This page is split into two parts:
- Settings
- Options



21

Installation and maintenance

D500
Automatic Voltage Regulators (AVRs)

4243 en - 2009.09 / aLEROY-SOMER

A1.1 - Settings

1. Write the desired voltage at the alternator 
output in the appropriate box.

1

2

3

2. To set the voltage externally, tick the box, define by what means (POT, 0-10 V, etc) this setting 
will be made as well as the selected input (AI1 or AI2), then enter the desired setting range.

3. If you wish to have quadrature droop, tick the box and select the quadrature droop 
percentage.
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A1.2 - Options

1

2

1. If you wish to have line drop compensation, tick the box and select the type of setting by a 
% value or an external setting. The standard setting is 3%.

                     Line drop compensation by value
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                   Line drop compensation by external setting

Line drop compensation cannot be selected when quadrature droop has been enabled.

2. Select which value regulation should apply to:
- mean value
- true rms value
 
To go to the next step "Underspeed settings", click "Next".
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A2 - Underspeed settings
This page is split into three parts:
- Starting
- Underspeed
- Motor help



25

Installation and maintenance

D500
Automatic Voltage Regulators (AVRs)

4243 en - 2009.09 / aLEROY-SOMER

A2.1 - Starting

Factory setting: disabled

To adjust Soft-start, tick the box and select the duration between 0.1 s and 120 s (1 step = 0.1 s).
Clicking on the question mark takes you to the help information on this characteristic.
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A2.2 - Underspeed

Factory setting: 48 Hz for 50 Hz
58 Hz for 60 Hz

1. Enter the knee-point value between 47.5 and 52.5 Hz (1 step = 0.1 Hz). An error message 
appears when the value displayed is outside the permitted range.

2. Enter the gradient value between 1.0 and 3.0 U/F (1 step = 0.1 U/F). Factory setting: 1/U/F.

1
2
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A2.3 - Motor help
1. If the LAM function is required, tick the box 
and select its value between 0% and 30% 
(1 step = 1%).
Factory setting: LAM 9% - U/F 1.7%

2. If you wish to have a gradual increase, tick the box and select the value between 0.1 s/10 Hz 
and 30.0 s/Hz (1 step = 0.1 s/10 Hz).

Save (see section 3, "Save" part).

1

2

Load the settings into the AVR by clicking 
the appropriate button. 

To configure another function, click the 
"Next" button and go to the corresponding 
page in this manual.
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B - Regulation of the power factor

Caution: You can only enable selection of regulation by power factor PF or selection of 
regulation of the reactive power KVAR, and the quadrature droop, if there is a CT on 
phase U which has been enabled on the alternator configuration page.

This page is split into two parts:
- Digital inputs
- Settings

B1 - Digital inputs

Check the digital input on which the voltage match circuit has been placed in order to enable it. 
The second digital input is reserved for enabling power factor regulation mode.
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B2 - Settings

1. Select the power factor value between 
0.9 LEAD and 0.60 LAG (1 step = 0.01).

1

It is impossible to enter a reference value outside the limit values which are automatically set 
from the data on the 1st configuration page.

Warning: When a value is outside the operating limits, a message appears as indicated 
below.

2
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2. To set the power factor externally, tick the box, select the source (POT, 0-10 V, etc) for this 
setting and also the input (AI1 or AI2). One of the inputs may be greyed-out if it is already being 
used for setting the alternator output voltage externally.

Save (see section 3, "Save" part). 
Load the settings into the AVR by clicking 
the following button.
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C - Regulation of the reactive power kVAR
Caution, regulation of the reactive power PF and the quadrature droop can only be 
enabled if there is a CT on phase U and it has been selected.
This page is split into two parts:
- Digital inputs
- Settings

C1 - Digital inputs
Check the digital input on which the voltage 
match circuit has been placed in order to 
enable it. The second digital input is reserved 
for enabling reactive power regulation 
mode.
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C2 - Settings
1

2

1. Select the value of the reactive power according to the load. This value is between 40% LEAD 
and 70% LAG.

Warning: When a value is outside the operating limits, a message appears as indicated 
below.
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2. To set the reactive power externally, tick the box, select the source (POT, 0-10 V, etc) for this 
setting and also the input (AI1 or AI2). One of the inputs may be greyed-out if it is already being 
used for setting the alternator output voltage externally.

Save (see section 3, "Save" part). 

Load the settings into the AVR by clicking the appropriate   
button.
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D - Manual regulation: I exc
This page is split into two parts:
- PC (settings)
- External control

Choose one of these two excitation current settings.

D1 - PC
Enter the desired excitation current value 
between 0.0 A and 10.0 A (1 step = 0.1 A). 
Manual mode is enabled by clicking the 
corresponding button.
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D2 - External control

1. To set the excitation current externally, 
tick the box, select the source (POT, 0-10 V, 
etc) for this setting and also the input (AI1 or 
AI2). One of the inputs may be greyed-out if 
it is already being used for setting the 
alternator output voltage externally.

2. Tick the digital input on which manual 
mode has been placed in order to activate 
it.

1

2

Save (see section 3, "Save" part). 

Load the settings into the AVR by clicking the button:   

Analogue control screen

Digital control screen

Adjustable scale
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Faults and digital outputs3.3.2.1.3 - 
This page is split into two parts:
- Assignment of faults
- Assignment of digital outputs

This page offers the possibility of assigning faults and operating modes to 4 outputs (AL1, AL2, 
D01 and D02).

Example of settings:
- Assignment of "Overvoltage" fault to AL1
- Assignment of "PT100-1 overtemperature" fault to AL2 with the maximum temperature set at 
200°C
- Assignment of "Loss of voltage sensing" fault to DO1
- Assignment of "PF/kVAR" digital output to D02
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Monitors3.3.2.1.4 - 
This page is only displayed when the AVR is connected to the computer. It consists of 15 digital 
control screens (voltage, frequency, current, etc), an analogue screen, 3 adjustment tabs 
(voltage, voltage stability and transient test) and displays the LED states.

1. The 15 windows display the alternator values compared to the enabled options. Both screens 
(Alternator I V and Alternator I W), framed in burgundy, are greyed-out when neither of the CTs 
have been selected.
By selecting 1 CT you can display: Alternator I U, Alternator P, Alternator Q, Alternator S, 
Alternator PF.
By selecting 3 CTs you can also display: Alternator I V, Alternator I W.
By selecting PT100 temperature sensors you can display: PT100-1, PT100-2, PT100-3.

2. Click this button to adjust the stability.

3. This part displays the LED status.

4. Click on the button to display the values. The speed at which data is read can also be set.

1

4

2 8

6

7

9

3

5 5
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5. These 2 indications show that the AVR is connected and its characteristics have been 
selected.

6. 2-signal display screen. Simply tick in one of the boxes (R or B) and set the scale (Max-
Min).

7. The CT phase angle should be compensated to improve the accuracy of the display by moving 
the "CT phase angle correction" slider.

8. Transient test:
- Select the alternator voltage and the excitation current
- Click on "Transient test"
- The test voltage level setting window appears
- Enter the values, confirm, wait for the process to end
Note: Set the minimum and maximum values within the range permitted by the generator 
voltage sensing device.

9. To start reading, click "Start reading". The reading speed can be adjusted by 0.1 s to 3 s.
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Expert3.3.2.2 - 
Expert mode is obtained by clicking on the 
"Parameters" menu, then "Level". The 
software offers the choice of either standard 
or expert. Click "Expert". A page opens and 
asks for a password.

This mode is reserved for users who possess 
the skills to make certain more complex 
adjustments or to use the AVR in a wider 
range of operating conditions.

Incorrect settings can harm the AVR 
and the alternator and can cause 

serious damage (to users, loads). 

Programming the AVR with the software in 
expert mode is similar to the method used in 
standard mode. The difference is apparent 
with certain operating ranges and some new 
settings:

Page New setting

Alternator Configuration Duty/Class
Faults & digital outputs Enabling/Disabling faults

Monitors PID actions
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Duty/Class3.3.2.2.1 - 
This setting can be found in the "Alternator Configuration" page.

Select the duty type and the class according to your specification.

Caution: This setting modifies the power ratings. Make sure all your choices are correct.
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Enabling/Disabling faults3.3.2.2.2 - 
This setting can be found in the "Faults & digital outputs" page.

1. To disable "Loss of voltage sensing", check the "Disabled" box
2. To disable "Iexc. protection", check the "Disabled" box
3. To disable "Overvoltage protection", check the "Disabled" box
4. To change the rated excitation current value, write the new value in the appropriate box.

1

3

4

2 Inversion of digital I/O  
and alarms
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PID action3.3.2.2.3 - 
This module can be found in the "Monitors" page.

To change the standard values, write in the blue boxes.

Caution: Setting the PID controller incorrectly may disturb the AVR operation, resulting in 
instability.

Proportional action value
Integral action value
Derivative action value
Gain value
Scale value
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PID controller
The PID controller is an important system 
for the AVR. It is used to adjust the static gain 
with the proportional part, stability with the 
derivative action and speed thanks to the 
integral action.

- Proportional action
This action affects the speed.
The smaller the proportional band, the lower 
the static error and the shorter the response 
time.

If Xp (proportional band) is small, there may 
be an overrun but if Xp is too large, the static 
error is greater.

- Integral action
This action changes over time and is used to 
reduce the static error.
It is filled in by the "Integral in relation to the 
time" mathematical operator.
In an AVR, the integral action is defined 
using one of two parameters: Ti integral time 
or Ki integral gain.

The smaller Ti is, the more quickly the value 
of output Y increases. The time Ti is the time 
it takes command Y to increase with the 
value of input E.

If Ti is too short, there is a strong possibility 
that the reference will be exceeded but if Ti 
is too long, the measurement takes longer to 
reach the reference.
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- Derivative action
This action amplifies abrupt variations in the 
reference. It has the opposite action to the 
integral action. This function is filled in by the 
"Derivative in relation to the time" 
mathematical operator. In an AVR, the 
derivative action is defined using the 
derivative time Td.

The larger Ti is, the greater the value of the 
Y output. The time Td is the time it takes 
input E to increase by the value of output Y.

If Td is too long, a static error appears but if 
Td is very short, the response is longer and 
a reference overrun occurs.

The table below summarises the effects which may be influenced by the PID actions.

PID controller Effect

Proportional action Speed
Integral action Accuracy 

Derivative action Stability
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CONNECTION DIAGRAMS4 - 
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≤ 7%

≥ 7%

Fault

Fault

Yes

Absence of voltage

Check the power supply is present 
on the AVR  

Green "POWER ON" LED active 

Check the regulation mode
 

Check the wiring and the 
supply voltage between 

12 and 30 Volts
 

 

Check whether the measured 
voltage    7% of UN  

Yes No

Check the polarity of the exciter field

Modify the wiring, 
then reboot the 

machine if 
necessary

 
 

 

Check the exciter field connections 
 

Modify the exciter field wiring or 
replace it if faulty 

Check the diode bridge Replace the diode bridge if faulty 

OK

Fault

Replace the AVR

Generator and control running

Start voltage regulation 

No

FAULT FLOW CHARTS5 - 
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OK
Fault

OK

OK

Fault
OK

Fault

Fault

Fault

OK

OK

Voltage too high/Red LED activated
VOLT

Check the value of the AVR 
Internal or external reference 
connected to the analogue 

input 

 
 

 

Measure the voltage sensing 
on terminal block 4  

 (380 - 220 Volt)

Correct the value of the external 
analogue input if necessary or 

the AVR internal reference

 
 

 

Replace the AVR

Generator and control running

Measure the electrical 
continuity of voltage 

sensing U V W
 

 

Modify the wiring

Check the USB link to 
terminal block 7  

Blue LED on

Check the connections or 
Replace the USB cable 

Re-install Easyreg
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OK

Fault

OK
OK

OK
Fault

≥ 7%
≤ 7%

Fault

OK

Fault
OK

OK

 Fault

  Fault

Voltage too low/Red LED on VOLT

Check the speed of rotation

Adjust the 
generator speed 

of rotation
 

 

Check and if necessary
adjust the position of the
U/F activation knee-point
 

 

Monitor the load applied to 
the alternator 

Check the exciter field

Replace the
exciter field Check whether the remanent 

voltage is ≤ 7% of UN

Replace the AVR

Generator and control running

Replace the
rotating diodes 

Check the USB link to 
terminal block 7  

Blue LED on

Check the connections or
Replace the USB cable 

Re-install Easyreg
 

Readjust the load
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Fault
OK

Fault
OK

Unstable

Stable

OK

OK

Fault

Fault

Fault

Fault

OK

OK

OK

Incorrect regulation or Voltage 
unstable 

Check the stability of the 
speed 

Correct the stability of the
drive system speed 

 
Check the D500

configuration
 (type of alternator and PID)

Modify the D500
configuration

Adjust the PID
Check whether the load 

is balanced 
Stabilise the load

Check the exciter field

Check the rotating diodes 

Replace the D500 AVR  

Replace the exciter field

Replace the rotating diodes
 

Generator and control 
running 

Check the USB link to
terminal block 7  

Blue LED on

Check the connections or 
Replace the USB cable 

Re-install Easyreg
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Fault

Fault

Fault

Fault

Fault

 OK

 OK

 OK

Response time too long

Does the speed regulator
respond quickly enough? 
 

Adjust the AVR stability
potentiometer in Easyreg 

 

Reduce the value of the
gradual voltage return

(7 s/10 Hz factory setting)

Adjust the speed stability 
of the prime mover 

 

Set the Monitor
Screen stability

Start generator and
control running 

Replace the D500 AVR
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OK

 OK

 OK

 OK Fault

 OK

Fault

Fault

Fault

Fault

 OK

Considerable drop in voltage, on-load

Check the generator
load level 

Check the quadrature 
droop parameter settings 

Check the wiring of the
voltage reference U/V/W 

Check the position and
location of the CT on

phase U
 

 

Decrease the load

Check the value of the 
CT and the ratio setting  

Replace the D500 AVR
 

Start generator and
control running 

Adjust the quadrature 
droop

(factory setting 3%)

Modify the wiring

Modify the wiring

Check the D500
configuration

(LAM, U/F, etc) 
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Fault

Fault

Fault

Enabled

Fault

Fault

Inactive

 OK

 OK

 OK

 OK

 OK

 OK

 OK

KVAR phase imbalance or
Incorrect PF regulation 

Check that KVAR or PF
mode has been enabled

(yellow LED on)
 

 

Check whether quadrature
droop has been enabled 

Check the no-load voltages
are matched before

connecting
 

 

Quadrature droop
disabled

Enable KVAR or PF
regulation (yellow LED on) 

 

Check the USB link
to terminal block 7 

Blue LED on

Check the wiring of the
voltage sensing U/V/W 

 

Check connections 
or

Replace the USB cable
Re-install Easyreg

 

Match the voltages

Check the position of the
CT on phase U (P1 at
source end) and the

output connections (S1-S2)

 
 

Replace the D500 AVR
 

Start generator and
control running 

Modify the wiring

Modify the wiring 
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 OK

 OK

 OK

 OK

 OK

Fault

Fault

Fault

Fault

Fault

 OK

 OK

PF or KVAR range incorrect

Replace the AVR 

Check the selection mode 
 (internal or external)

Check that KVAR or PF
mode has been enabled 

Start generator and
control running 

Enable KVAR or PF
regulation (yellow LED on) 

 

Check the USB link to
terminal block 7 

Blue LED on

Check connections 
or

Replace the USB cable
Re-install Easyreg

 

Enable the setting mode
 

Check and modification of
the setting range and limits 
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 OK

 OK

 OK

 OK

 OK

Fault
Fault

Fault

  Voltage matching impossible

Check that there is a
mains voltage reference

on terminal block 4
 

 

Check that U = U mode
has been enabled
(yellow LED on)

 
 

Replace the AVR

Check and modify, if
necessary, the wiring of

the digital input on
terminal block 8 DI1 DI2

 
 

 

Start generator and
control running 

    Modify the wiring

Check the wiring of the
mains voltage on
terminal block 4 
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LED status

Speed drop

Board supplied with powerGreen "POWER
ON" LED active 

Problem of overvoltage
or undervoltage 

Hz  Red LED
on 

/   Volt Red
LED on 

/    Exc Red
LED on 

Problem of overvoltage
or undervoltage 

Manu yellow
LED on 

PF/KVAR
Yellow LED on

 

Blue USB
LED on 

Manu Yellow
LED on 

Manual mode enabled

Regulation of the power
factor or reactive
power enabled

 
 

 

Alternator/mains
voltage matching 

AvrSoft software/
D500 communication 
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